
Introduction to Windows 10
Part 3



In this presentation we will touch on the following topics:

• Connecting to a wireless network
• Accessing the internet
• Changing your account picture
• Configuring programs to start automatically with Windows 10

Including the following apps:

Microsoft Edge
Windows 10 Mail



Connect to a Wireless Network

Note that the            Network icon in the Notification area shows “Not connected - Connections are available”

Click the icon to display the connections and select your main wireless network.  Click 
the box to Connect automatically (if it is a network you are likely to use more than once) 
and then “Connect”. 

Enter the network security key for the wireless network and click Next (or press the 
Router button to connect without entering the key).

Your computer is now shown as connected to the wireless network.

Your system may detect other wireless networks that are in the vicinity, so make sure to select the correct entry.

If you have selected “Connect automatically” your computer will now always connect to that network when it comes 
into range. You can have numerous wireless connections defined, for example home, office and an internet cafe.



Internet

Windows 10 provides two internet browsers to help you navigate through the web – the new app, Microsoft 
Edge, and the older program, Internet Explorer. By default, Windows 10 provides access to the internet via 
Edge and will open any internet hyperlink using Edge.

You may have heard of other browsers, in fact you may already be using one or more of them. The most 
common browsers, all of which are free to download and work well with Windows 10, are:

• Chrome, developed by Google
• Firefox, by Mozilla
• Opera
• Safari, originally developed for Mac but now available for Windows

There are several less mainstream browsers which you may care to test, including Yandex, Comodo Ice Dragon 
and Maxthon.

Note that there is no limit to the number of browsers you can install and use, even simultaneously. Some 
websites are designed to be viewed in one particular browser and may not display correctly in others, so 
there is nothing wrong with having several different browsers installed. 



Edge
Click the Microsoft Edge icon on the Taskbar to open the app.

The Start screen displays, with a News channel provided by MSN. Scroll down for more news items. You can 
change the start page if MSN News is not to your liking.

You can also start Microsoft Edge from the All Apps list. 

You can scroll the screen with the mouse wheel, with the scroll 
bar that appears when you move the mouse, or by dragging 
the scrollbar on a touch monitor.



Click in the Search box at the top of the Start screen and begin typing, to see related Search suggestions.

Choose one of the Search suggestions to see the list of web pages matching those terms.



Select one of the web pages and let’s explore the commands that are available.

On the next slide we will look at these commands in a little more detail.

To add a web page to your 
Favourites list click the Add to 
favourites button while viewing 
the page. 



Back Back to previous web page
Forward Forward to previous web page after going back

Refresh Reload the page
New Tab Open another tab while keeping the current one open

Address bar The address of the current web page
Reading View See to the right

Add to Favourites Save the web address to make it easy to return in future
Hub Covered in a later slide
Make a Web Note Covered in the next slide

Share See below
More Options See below

Other actions are available 
in More Options.

“Share” allows you to send either a link to 
the page, or a screenshot, by mail or using 
OneNote.



Web Notes

Open a web page that you’d like to annotate and click the New Web Note button.  The Web Notes toolbar is 
added, including pen options, text boxes (Note), Save and Share.

You can use the pen (blue) and highlighter (yellow) to doodle on 
the screen, or the text box to make notes. The 3rd icon on the left 
is an eraser to remove doodles.



Clicking on the clip icon              brings up the overlay shown below. You can then click and drag to define an area 
to be copied.

When you have finished, if you want to keep your Web Note, select Save (         ), select where to save: click 
OneNote (without a file name),  Favourites or Reading list (check the suggested name), then click Save. You can 
also Share (          ) it using any of the listed options (which depend on the programs stored on your computer).

If you do not want to save it, simply click on          .



The Hub is where Microsoft Edge keeps all of the things you collect on the web and gives access to the Favourites, 
Reading List, History and Downloads. It normally opens on Favourites, where you can store links to web pages you are 
likely to want to revisit.

Click Reading List to view the list of 
pages you have added, plus any Web 
Notes you have created.

History records web pages viewed by date: click on the right-
facing arrow to expand any day’s browsing activity.

Downloads records files and documents you 
have downloaded with Edge and has an “Open 
folder” link to the folder where these are stored.



To configure Microsoft Edge, select More Options (...) and then Settings

Choose a Theme: you can 
have the default Light theme 
or the Dark theme. 

Open Microsoft Edge with / Open new tabs with
There’s no Home page but here you can choose the Start page if 
you don’t like MSN News, and select what appears on new tabs.

Reading offers four view styles: the Default, plus Light, 
Medium and Dark. 
The font size can also be adjusted: Small, Medium (the 
default), Large and Extra Large.



The Advanced Settings screen in Edge is very long, so has been chopped into 3 to display 
here.



Account Picture

You can specify a photo or image that will be used alongside your username on the Start menu:

• Open Settings and select Accounts, or right-click the username on the Start menu screen and 
select Change account settings, then click “Your info”.

• Click “Browse for one” to select an existing photo or other image from your Pictures library or 
another folder on your computer.

• Alternatively, if your computer has a webcam or built-in camera, select Camera to take a picture.
• You can take a still photo or a video, but the video is limited to five seconds.
• Press the Windows key to toggle between the Settings screen and Start menu, to see the results.

You can select or create a picture of any size and it will be converted to the appropriate size for use with the 
Start menu or other functions related to your Microsoft Account.

However, make sure you select a square image, as you can’t crop or move the image once you have selected 
it as your Microsoft Account photo.



Configure programs to start automatically each time you open Windows

It is possible to set one or more programs to start whenever you turn on your 
computer, by carefully following these steps.

• Open the “Run” command by pressing “R” and the Windows key simultaneously. 
The window will look like this:

• In the box in the centre type “shell:startup” (without the quotes), click on OK and 
the “Run” window will be replaced by a new window headed “Start-up” (see next 
slide).

Windows key



The right-hand pane of this window 
shows the programs which are set to 
open automatically as soon as Windows 
opens.

If you want to remove any of these 
programs simply delete the entries 
(which are only shortcuts and will not 
affect the actual program).

To add a new program to the list you will 
need to find its exe file by following the 
steps on the next slides.

Start by clicking on “File” in the top left 
of this window, then on “Open new 
window” and “Open new window”.



You should now have 2 copies of the same window, 
one on top of the other. You need to adjust the size 
and position of the windows so that both are 
visible.

To move a window hold down the left mouse 
button on the title bar and drag the window left, 
right, up or down. Try not to double-click as this will 
maximise the window and fill the screen.

To change the size of a window move your mouse 
pointer to the edge of the window where the 
pointer will change into a double-headed arrow 
(vertical at top and bottom, horizontal at left and 
right). Hold down the left mouse button and drag 
the edge in the desired direction.

You can also adjust the width and height 
simultaneously by putting the mouse pointer on 
the corner of a window until the pointer changes to 
a diagonal double-headed arrow.

Do you remember an earlier slide about “snapping” windows? Would that be useful here?



The aim is to get the windows 
looking something like this.

The next step is to navigate 
through one screen to find the 
exe file of the program you 
want to start automatically, 
and create a shortcut which 
you can paste into the other 
copy of the Start-up folder.

For the purposes of this 
exercise we will assume that 
we also want to open Excel 
automatically at start-up.



We now need to navigate to the exe file of the program we want to open. The starting point is normally the Program 
Files or Program Files (x86) folder, almost always located on the main hard drive (normally the C drive).  

In this instance we are looking for Excel, which is part of the 
Office suite, so need to find the Microsoft Office folder. To 
navigate through the different levels of folder structure, click on a 
right-facing arrow to reveal the contents. 



In the right pane of the left-
hand window, right-click on 
EXCEL.EXE and choose “Copy”.

Then right-click in the right 
pane of the other window and 
select “Paste shortcut”.

Both windows can now be 
closed, and the next time 
Windows 10 is started, Excel 
will also open automatically.

In the case of the computer on which these screenshots were taken, the path to the Excel exe file is as follows:
C/Program Files (x86)/Microsoft Office/Office 15, but the last folder is only there because this computer still has elements 
of earlier versions of Office installed. Any 64-bit programs will be in C/Program Files rather than C/Program Files (x86).



Often, however, what is needed is to stop programs opening when Windows starts: the more that starts with 
Windows the slower your computer will start up (and often the slower it will run).

In Windows 10 details of these programs can be found in an app called the Task Manager. You can access this 
from the Start menu, then Windows System and Task Manager. Alternatively simply press Ctrl, Alt and Delete at 
the same time, then select Task Manager from the list of options.

Task Manager



Task Manager will open in a new 
window like the one on the right.

Unless you know exactly what you 
are doing it is probably best to 
leave most of the tabs alone, but 
looking at the applications and 
processes on the Start-up tab can 
often give an idea of what 
unnecessary processes use 
resources during startup. 



The Start-up tab lists all apps which can start with 
Windows, together with the publisher, status 
(whether currently enabled or disabled) and the 
impact each app has on startup. Clicking on a 
program which is currently disabled will show an 
“Enable” button at the  bottom right of the screen. 
Clicking on an enabled program changes the button 
to “Disable”.

Be very careful when disabling programs. It is 
best to change settings one app at a time, 
restarting a couple of times to ensure there has 
been no negative impact before changing another 
setting.



Windows 10 Mail App

To get started with the Mail app:
• On the Start menu select the tile for the Mail app.
• Click Get started.
• If you have just one email account that’s the same as your Microsoft 

Account, click “Ready to go”, or if your email account is separate from your 
Microsoft Account, click “Add account”.

• Select your account type, for example Yahoo Mail, enter your email address 
and password, then click “Sign-in”.

• Specify your name as it should appear on your emails, then click “Sign-in”.
• Click Done when the account has been added successfully.
• Mail automatically detects your Microsoft Account and connects to that 

email service. This becomes the Outlook Account, even if your Microsoft 
Account is a non-Microsoft email.

• To add another email account, click Add account again, or click Ready to go if 
there are no more to add at this time.



When Mail starts up, the display layout that you 
see depends on the screen resolution. On a 
higher resolution monitor, in this case 1280 x 
1024 pixels, you’ll see three panes – Accounts, 
Current Folder and Reading. (If you have 
multiple email accounts, click the Accounts icon 
to change accounts.)

On a lower resolution monitor (the example below 
is just 1024 x 768 pixels) you’ll see only two folders, 
the Current Folder and Reading panes, plus a menu 
icon list.

Click the Menu button on the icon bar 
to display the titles for the icons.



The Mail Window
These are the main elements of the Mail window:

Click the More Options button (...) at the top 
right of the window to display additional 
commands for dealing with the messages in 
your Mailbox.

Click the Zoom button 
to list the scale factors 
offered

The Mail tile on the Start menu displays the message count and message extracts (even when the Mail app itself is closed).



View Messages
Select a message from the Folder pane and it displays in the Reading pane.

If there is an attachment (as indicated by a paperclip icon) it will be contained within the email body or shown as a link.

Click “Reply” to respond to the sender, “Reply all” for all addressees, or “Forward” to send to another person.

Type your reply and click the “Send” button when finished. A copy is saved in the “Sent” folder of the account used to 
send the reply. Pictures can be included in the body of email messages, as well as saved from them. Other files such 
as documents can also be sent, saved or opened from a message.

Note: In the majority of e-mail programs, attachments are removed when you select “Reply” or “Reply all”, but 
retained in forwarded messages.



Create a Message

In Mail, select the email account, go to the Inbox and click the New mail button (or press Ctrl + N).  
A blank message is displayed, ready for recipient details and content. 

Begin typing the contact name in the To: box, then select the contact 
when it appears in the results below.

Add more recipients in the same way, selecting from the suggestions 
where appropriate. Entries will be separated by semi-colons.

Click in the Subject box and type the text for the title of the message.
Click in the body of the message and add the salutation and the message text.
End with your name, then the email signature for the sending account will be added 
automatically, if you have this set up.

When entering contact names in the To: box, you may see several suggestions 
that match so far, but the number reduces as you enter more of the name.

Select Cc & Bcc (Recipients added using Bcc (Blind carbon-copy) will not be shown on the copies of the 
message that others receive) to add boxes for recipients who will be copied on the email.

You can format the text in your message if you wish – click the Styles 
button to see more options. There are also limited Font and Paragraph 
formatting options.



A copy of the message is kept in the Sent folder of the sending account. 

Should there be any problems with the email addresses used for the recipients, you may receive a 
message from the Mail Delivery System describing the problem and its cause.

Sometimes a message to an email address 
may fail, perhaps because the domain server 
is offline for a period. After several attempts, 
an error response message may be returned 
to you.

Click the “Send” button to send the message.



Importing pictures from a phone or camera.

The first thing to do is to ensure that your laptop or PC recognises your phone or camera when they are connected. 
Using a USB lead is generally best although in some cases the 2 items can be connected by Bluetooth or wirelessly. 
Most digital cameras have removable memory cards, Secure Digital (SD, SDHC or SDXC) or their mini- and micro-
types being the most common, although the earlier Compact Flash format (CF) is still available as are other non-
mainstream card types. Sometimes it is easier to remove the memory card from the camera, put it in a card reader 
and attach that to the USB port on your PC.

Often when you connect a device such as camera, phone or 
card reader to your PC for the first time, Windows will ask 
you to choose what to do. The choices will depend on the 
content on the card and also the programs installed on your 
pc, but will probably include some of those shown on the 
right:

“Ask me every time” is probably the safest option, but can 
be a real fiddle. Importing photos through any app or 
program risks not knowing where to find your pictures 
afterwards. For maximum control over the operation we 
recommend you select “Open folder to view files (File 
Explorer)”. 

If you previously selected one of the other options you can change it in Start/Windows System/Control Panel/Auto Play



If you want you can still use a 
wizard to import pictures from 
File explorer. Right-click the 
icon for your camera or card 
reader and select “Import 
pictures and videos”.

The wizard will start and go 
through the steps on the 
following slide.



When the Camera import wizard starts, go with the default option then click Next.

If you want to customize where Photos and Videos are stored, 
click More options at the bottom left corner. Click Browse 
then choose where you want your photos and videos to be 
stored automatically.

Most people prefer to have a little more control over naming of folders 
and the actual import process, and choose instead the manual import 
process which is both easy and fully customisable to one’s own 
preferences.

http://fud.community.services.support.microsoft.com/Fud/FileDownloadHandler.ashx?fid=3eb3b33c-1e82-4579-b3f1-aa886c6f9a5e


In File Explorer, locate and open the 
DCIM folder on your phone, camera 
or memory card. (You may also need 
to open a sub-folder to see the 
latest pictures.)

If the folder opens with just a list of 
contents like this:

….click on the “View” tab at the top of the page and select 
“extra large icons



Select the photos you want 
by using the Control key and 
mouse click.

Then copy your images by:
• Clicking the “Copy” icon 

on the Home tab, 
• Pressing Control + C, or
• Right-clicking and 

selecting “Copy”.

Then navigate to the 
destination folder on your 
PC (such as “My Pictures”) 
and paste the images by:
• Pressing Control + V,
• Right-clicking and 

selecting “Paste”, or
• Clicking the “Paste” icon 

on the Home tab.



Many people find the process easier to 
visualise if they have 2 copies of File Explorer 
open at the same time, as shown on the 
right. In this way it is possible to see both the 
source and destination folders 
simultaneously.
To open a second copy of File Explorer, right-
click its icon on the taskbar and select “File 
Explorer”.

With both windows open it is now simple to arrange them side by side using the Windows key and left or right arrows.



A very comprehensive guide to importing photos from cameras and phones, including iPhone, Android and Windows 
phones can be found at:
https://answers.microsoft.com/en-us/windows/wiki/apps_windows_10-photos/complete-guide-to-importing-your-
photos-in-windows/d8258fff-729e-45df-8afd-1f1195d7b6c5

With 2 copies of File Explorer open like this, it is 
also possible to drag files and folders from one 
screen to the other. Simply click on a file and while 
holding down the mouse button, drag it to where 
you want it on the other screen.
Holding the left mouse button will normally copy 
the file, while holding the right mouse button will 
offer a choice of copying or moving the file.

https://answers.microsoft.com/en-us/windows/wiki/apps_windows_10-photos/complete-guide-to-importing-your-photos-in-windows/d8258fff-729e-45df-8afd-1f1195d7b6c5


THE END
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